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Instructor notes
Getting Started
The Adobe InDesign CS5 Classroom in a Book™ course presents students with 
tips, techniques, and solutions for using the Adobe InDesign CS5 software. The 
Instructor Notes are intended to complement the information in the Adobe 
InDesign CS5 Classroom in a Book.

The information is organized to follow the sequence of instruction in each lesson.

About the workbooks
It is recommended that each student in the class have an individual copy of the 
Adobe InDesign CS5 Classroom in a Book. Students will use this book as you lead 
them through projects. Additionally, the book can be used as a self-paced tutorial.

Course strategy
You can teach approximately one chapter of this book per class. The book con-
tains 14 lessons, some of which may take a while to complete. If you are teaching a 
10-session class, you may want to combine some of the lessons in a single class. For 
example:

•	 Lessons 5, 6, and 7 focus on different aspects of importing, editing, and 
formatting text

•	 Lessons 4 and 10 focus on working with objects and graphics.

We recommend that, at an absolute minimum, you teach Lessons 1 through 10 
along with 13 (Lessons 11, 12, and 14 cover more special-purpose features.) The 
majority of the basic Adobe InDesign features and the InDesign work environment 
are covered in these lessons. However, completing all the lessons is a far superior 
introduction. Before beginning a lesson, encourage students to browse through it, 
and read any sidebars. 

Managing student projects
One way to simplify file storage and retrieval in classroom situations is to ask 
students to create a folder on their hard disks, name it [Student’s, for the student’s 
name] Lessons, and then copy each project folder into the main Lessons folder. 
Having students keep all their working files in their own Lessons folder makes it 
easy for you to clean up files when a class is over.
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Additional resources
Adobe InDesign CS5 Classroom in a Book is not meant to replace documentation 
that comes with the program or to be a comprehensive reference for every feature. 
Only the commands and options used in the lessons are explained in this book. For 
comprehensive information about program features and tutorials, refer to these 
resources:

Adobe Community Help:  Community Help brings together active Adobe product 
users, Adobe product team members, authors, and experts to give you the most 
useful, relevant, and up-to-date information about Adobe products. Whether you’re 
looking for a code sample or an answer to a problem, have a question about the 
software, or want to share a useful tip or recipe, you’ll benefit from Community 
Help. Search results will show you not only content from Adobe, but also from the 
community.

With Adobe Community Help you can:

•	 Access up-to-date definitive reference content online and offline

•	 Find the most relevant content contributed by experts from the Adobe 
community, on and off Adobe.com

•	 Comment on, rate, and contribute to content in the Adobe community

•	 Download Help content directly to your desktop for offline use

•	 Find related content with dynamic search and navigation tools

To access Community Help: If you have any Adobe CS5 product, then you already 
have the Community Help application. To invoke Help, choose Help > InDesign 
Help. This companion application lets you search and browse Adobe and commu-
nity content, plus you can comment on and rate any article just like you would in 
the browser. However, you can also download Adobe Help and language reference 
content for use offline. You can also subscribe to new content updates (which can 
be automatically downloaded) so that you’ll always have the most up-to-date con-
tent for your Adobe product at all times. You can download the application from 
www.adobe.com/support/chc/index.html

Adobe content is updated based on community feedback and contributions. You 
can contribute in several ways: add comments to content or forums, including links 
to web content; publish your own content using Community Publishing; or contrib-
ute Cookbook Recipes. Find out how to contribute: www.adobe.com/community/
publishing/download.html 

See http://community.adobe.com/help/profile/faq.html for answers to frequently 
asked questions about Community Help.

Adobe InDesign Help and Support: www.adobe.com/support/InDesign where you 
can find and browse Help and Support content on adobe.com.
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Adobe TV: http://tv.adobe.com is an online video resource for expert instruction 
and inspiration about Adobe products, including a How To channel to get you 
started with your product.

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles on 
design and design issues, a gallery showcasing the work of top-notch designers, 
tutorials, and more.

Adobe Developer Connection: www.adobe.com/devnet is your source for technical 
articles, code samples, and how-to videos that cover Adobe developer products and 
technologies.

Resources for educators: www.adobe.com/education includes three free curricu-
lums that use an integrated approach to teaching Adobe software and can be used 
to prepare for the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Forums: http://forums.adobe.com lets you tap into peer-to-peer discussions, 
questions and answers on Adobe products.

Adobe Marketplace & Exchange: www.adobe.com/cfusion/exchange is a central 
resource for finding tools, services, extensions, code samples and more to supple-
ment and extend your Adobe products.

Adobe InDesign CS5 product home page: www.adobe.com/products/InDesign

Adobe Labs: http://labs.adobe.com gives you access to early builds of cutting-edge 
technology, as well as forums where you can interact with both the Adobe devel-
opment teams building that technology and other like-minded members of the 
community.

Adobe Design Center
The U.S. Adobe website at www.adobe.com contains a variety of InDesign train-
ing and support resources, including the Adobe Design Center for InDesign. Many 
step-by-step tutorials, galleries, and other resources are available at the Adobe 
website, and the User-to-User Forums are a great place for students to learn from 
more experienced users. Adobe Design Center provides hundreds of tutorials from 
experts and authors in the community, as well as thoughtful articles about design 
and technology. 

Go to: www.adobe.com/designcenter/

Adobe Certified Expert (ACE) program
This program is designed to validate an expert skill level of Adobe InDesign CS5. 
Careful testing of candidates ensures that each ACE has demonstrated expert 
product knowledge of the current release of Adobe InDesign, resulting in increased 
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marketability and an added credential. Training for the ACE program is available 
through Adobe Authorized Training Center (AATC) and self-study.

For more information about this program, send an e-mail to certification@adobe.
com or visit the Adobe website at: www.adobe.com.

Lesson 1: Introducing the Workspace
This lesson provides an overview of the work area and basic functionality of 
InDesign. By the end of the lesson, students should understand the overall interface 
of InDesign, including, how to access tools and panels along with how to manage 
windows, navigate pages, and change a document’s magnification.

Tools panel
Pages 11–13: Many of the tools have popup options—so tools you need to access 
may be hidden beneath other tools. The tool tips for each tool display its name and 
single-letter shortcut. In addition, the Tools panel can be configured in various ways, 
including horizontal. 

Application bar and Control panel
Pages 13–15: The Application bar displays across the top of the screen by default, 
but can be hidden to save screen space (Mac OS only). The Control panel also 
displays across the top of the screen; most users keep it open but you may wish to 
move it to the bottom of the screen.

New window
Page 16–17: It is important to note that new windows are not the same as new 
documents. You can create multiple views of the same document, opening new 
windows as necessary. 

Panels
Page 17–21: With the proliferation of panels in InDesign, it’s important to keep the 
workspace neat and organized. Encourage students to learn to open, close, dock, 
float, collapse, expand, and group panels to meet specific needs. Students do not 
need to master the entire gamut of panel management techniques—they simply 
need to decide on a favorite based on their monitor size and work style. 

Workspaces
Page 22: InDesign CS5 provides a variety of default workspaces, which are panel 
configurations for specific purposes such as preparing for output or fine-tuning 
typography. Users can save their own panel configurations as workspaces as well. 
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Panel menus
Page 21: Make sure students know that panels have menus that provide additional 
features and panel-customization options. 

Zooming
Page 22–24: While the Zoom tool works well, you can work more efficiently by 
holding down the modifier keys to temporarily activate the Zoom tools. Use 
Command + Spacebar (Mac) or Ctrl + Spacebar (Windows) to temporarily activate 
the Zoom tool, which allows you to quickly increase your magnification without 
having to switch tools. You can find other zoom controls in the View menu and on 
the Application bar.

Navigating and scrolling
Page 24–26: InDesign lets you “turn pages,” jump to a specific page, and scroll 
through documents. You can also use the space bar to temporarily activate the hand 
tool to scroll through a document. When entering text, using the Alt (Windows) or 
Option key (Mac OS) to temporarily access this tool, rather than needing to switch 
using the Tools panel. Another shortcut option is to simply use Alt+Spacebar 
(Windows) or Option+Spacebar (Mac OS) any time, no matter what context.

Context menus
Page 26: Context menus are widely used throughout InDesign—for example, you 
can modify an object’s stroke weight from a context menu or start a spell check 
within text. To display context menus, Control+click (Mac OS) or right+click 
(Windows) on objects, within text, on pages, and more. These helpful menus pro-
vide quick access to frequently used features. 

Questions
1	 How can you save a panel configuration?

2	 If you are looking for a tool and it is not visible, where might it be located?

Answers
1	 Panel configurations are saved as workspaces (Window > Workspace > New 

Workspace).

2	 Some tools are nested, as they are located behind other tools. You must click and 
hold down on a tool to select any tools that are nested behind it.
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Lesson 2: Getting to Know InDesign
This lesson provides an overview of all the key features in InDesign, from opening 
files to adding text to working with graphics. The lesson focuses on “best practices,” 
showing how keeping output in mind can prevent eventual problems and using 
styles can streamline production. 

Adobe Bridge window
Pages 32–33: Many Adobe Creative Suite workflows depend on Adobe Bridge for 
organizing files. Point out how much more information is available about a file 
when opening it through Bridge, including Metadata and Previews. 

Preflight panel
Pages 35: While students are not ready for output, the Preflight panel is introduced 
to show that all design decisions—even in the early stages—can impact final output. 
Students should get in the habit of keeping an eye on the Preflight panel to prevent 
common errors such as missing fonts, incorrect color usage, overset text, and more.  

Viewing layout aids
Pages 36: Explain that layout aids such as guides and hidden characters are crucial 
to fine-tuning a layout. Since users show and hide them so often, it’s worth memo-
rizing the keyboard shortcuts for your favorite layout aids. 

Text and threading
Pages 37–39: Point out that students use the Type tool for creating text frames, typ-
ing text, and editing text. Any tool can be selected for importing text. The Selection 
tool, however, is the only tool you can use for threading text frames.

Styles
Pages 40–44: Styles are introduced here to get users in the habit of working with 
basic styles even on simple documents. For example, most documents will have 
paragraph styles for Head 1, Head 2, and Body Text. Creating and applying these 
will significantly streamline text formatting for the remainder of the document. 

Graphics
Pages 44–46: Importing, placing, repositioning, and cropping are key elements of 
working with graphics. 
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Objects
Pages 46–49: Objects are the building blocks of pages, so it’s important that users 
know how to move them, change their formatting, and wrap text around them.

Questions
1	 What are some advantages of using styles?

2	 What are the key tools you need for working with text and graphics?

Answers
1	 When you use styles, you can apply multiple formats to text and objects in 

one click. If you change your mind about formatting, you only need to modify 
the style rather than every object. This ensures quick, consistent formatting 
throughout a document.

2	 To work with text, use the Type tool. To work with graphics inside frames, use 
the Selection tool or the Direct Selection tool.

Lesson 3: Setting Up a Document and Working 
with Pages
This lesson provides the foundation for creating new documents. It explains how to 
create new documents with custom page sizes, set up a master page, apply a master 
page to document pages, create sections, add and arrange document pages, and 
change the size of pages.

Saving custom document settings
Page 55–56: You are not required to create a document preset before creating a new 
document. You should create document presets only if you will be frequently reus-
ing custom page settings, such page size and margins.

Using a document preset
Page 56–57: After defining a document preset to start the lesson, the next step is 
using it as the starting point for a new document. Using a preset saves time and 
ensures that all of the settings in the New Document dialog box are correct.

Master pages
Page 57–77: An understanding of master pages is critical for anyone who will be 
creating multipage documents. Master pages help ensure design consistency and 
streamline the task of page layout in long documents.
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Guides
Page 58–59: You can place row and column guides, as well as ruler guides, on docu-
ment pages and master pages. Notice that when a guide is placed on a master page 
it is not editable (you cannot select it) on document pages based on the master page. 
Students may either need to break the master link to a guide or reposition it on its 
master page.

Placeholder frames for graphics and text
Page 61–74: It is not necessary to create placeholder frames before importing graph-
ics or text. While this lesson uses a foundation of placeholder frames on master 
pages to create a consistent layout, you can also create frames on document pages 

“on the fly” when you import graphics and text.

Applying master pages
Page 75–77: The Pages panel is an invaluable tool for working with the pages in a 
multipage document. It displays thumbnails of master pages and document pages 
and lets you assign a master page to each document page. The Pages panel is also a 
useful navigation tool. Double-clicking a thumbnail displays that page in the docu-
ment window.

Adding sections
Page 77–79: Many documents, especially long documents with front matter, don’t 
start with page number 1 but instead begin on page that uses a different numbering 
system, for example upper case or lower case Roman numerals. The ability to specify 
independently numbered sections and choose among several numbering styles 
allows you to create custom numbering schemes within long documents.

Adding pages
Page 79: As an alternative to using the Insert Pages command in the Pages panel 
menu, you can drag master page icons from the top of the Pages panel to the bot-
tom of the panel to add pages to a document. Students can also choose Layout > 
Pages > Insert Pages as another alternative.

Arranging and deleting pages
Page 80: As an alternative to dragging thumbnails in the Pages panel, choosing 
Layout > Pages displays a menu with several commands for working with the pages 
and spreads in a multipage publication, including Add Page, Insert Pages, Move 
Pages, Duplicate, and Delete.
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Placing text and graphics
Page 80–82: When students attempt to place the palm tree image (03_d.psd), in step 
3, it may prove difficult. Tell students to watch the cursor (the loaded graphics icon) 
to tell when to place the image. If they click too low on the graphics frame, they will 
place the picture in the text frame that is on top of it on the master page. Tell them 
to click on the very top portion of the graphics frame where it doesn’t overlap the 
text frame. If they don’t place the graphic in the correct frame, they can choose Edit 
> Undo to return to the loaded graphics icon and try again.

Overriding master objects
Page 83–85: If you want to detach all objects on the current page or spread from 
their master page rather than detach a single object, choose Detach All Objects 
From Master from the Pages panel menu.

Rotating spreads
Page 84: This feature, introduced in InDesign CS4, is particularly useful for laying out 
landscape-oriented pages in documents with portrait-oriented page dimensions and 
vice versa. When you print a document with rotated pages, InDesign will automatically 
adjust the orientation of the rotated pages so that they print correctly, which means that 
you don’t have to unrotate pages before printing.

Changing page size
Page 85–88: Previous versions of InDesign restricted you to using the same dimen-
sions for every page in a document. With InDesign CS5 a document can contain as 
many different-sized pages as you want. For example, you can create a single docu-
ment that contains all of the various-sized publications that make up a corporate 
identify—a business card, a letterhead, an envelope, and so on.

Questions
1	 How can you avoid repetitive document-setup work if you often use the same 

settings for new documents?

2	 When are master pages most useful?

3	 What are some of the functions of the Pages panel?

4	 Can a document include pages with different sizes?

Answers
1	 You can create a Document Preset or a template document. A Document 

Preset includes all of the settings in the New Document dialog box. A template 
document includes the settings in the New Document dialog box and can also 
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include additional elements, such as master pages, color swatches, and styles 
(paragraph, character, object, and so on).

2	 Master pages are helpful for long documents with repetitive page formatting, 
such as running headers, running footers, or a consistent layout used on a 
number of pages.

3	 The Pages panel displays thumbnails of a document’s master pages and 
document pages. It includes controls and commands for adding and deleting 
master pages and document pages and for rearranging document pages. You can 
also use the Pages panel for navigation by double-clicking the page you want to 
display.

4	 A new feature in InDesign CS5 lets you change the size of any page in a 
document. Use the Page tool to select the pages you want to change, and then 
modify the Width and Height values in the Control panel.

Lesson 4: Working with Objects
In this lesson students learn that building pages with InDesign primarily involves 
placing content (text and graphics) within containers (text frames and graphics 
frames) and modifying these two basic types of objects.

Working with layers
Page 95–98: Layers is a key concept. These pages take students through the basics 
of layers and make them aware of the layer on which they are currently working. It’s 
important for students to understand that layers are not appropriate for all docu-
ments. For example, simple documents with few objects may not benefit from hav-
ing layers. Also, if a document is initially set up with layers, it’s easy to forget about 
them later when design or production begins.

One thing that often trips up novice InDesign users is a locked layer. If you encoun-
ter an object that cannot be selected, it’s possible that the object is a master item, 
the object has been locked (Object > Lock Position), or the object is on a locked 
layer.

Using Smart Guides
Page 99: Smart Guides can be very helpful when creating, resizing, and positioning 
objects. However, when working on a page with numerous objects, Smart Guides 
can become cumbersome. The Smart Guide Options in the Guides & Pasteboard 
section of the Preferences dialog box, include four checkboxes for specifying which 
Smart Guide features you want to use and which ones you want to turn off.



Adobe InDesign CS5 Classroom in a Book  13

Text frames
Page 95–106: Because most text elements are rectangular, the Type tool is the most 
appropriate tool for creating text frames. However, you can use any frame as a con-
tainer for text. The Content command (File menu) lets you change the content of an 
empty frame. For example, you can change an empty text frame to a graphics frame 
by selecting the frame and choosing Object > Content > Graphic. An Unassigned 
frame has no content and is neither a text frame nor a graphics frame.

Fitting frames to their content
Page 101, step 7: If possible, allow students to practice in the pasteboard area with 
sample text and graphics frames by double-clicking different frame handles to  
see the results (especially with pictures). Point out the difference between double-
clicking a corner handle (all four edges of the frame align with the edges of the 
graphic) and a midpoint handle (only the nearest edge and the opposite edge of  
the frame align with the edges of the graphic).

Changing the shape of a text frame:  
Selection tool vs. the Direct Selection tool
Page 102–103: It is important to understand when to use the Selection tool and 
when to use the Direct Selection tool when working with frames. Use the Selection 
tool to change the dimensions of a frame; use the Direct Selection tool to change 
the shape of a frame by moving anchor points. It’s easy to forget which tool you are 
currently using. If you accidently modify a frame using the wrong tool, choose Edit > 
Undo and then select the correct tool.

Graphics frames
Page 106–114: In addition to placing graphics within frames created with the 
Rectangle Frame tool, the Ellipse Frame tool, and the Polygon Frame tool, you can 
also place graphics within frames created with the Rectangle tool, the Ellipse tool, 
and the Polygon tool. Warn students that while it’s possible to place graphics within 
a text frame, the result is an anchored graphic, which behaves differently (like a 
character within text) than a graphic placed within a frame that’s not a text frame.

Importing a graphic
Page 108–109: If a frame is selected when you choose the Place command, the 
graphic you import is placed within the frame. If nothing is selected when you 
choose Place (this situation is covered on the next page of the training), clicking or 
clicking and dragging the loaded graphics icon will create a new graphics frame and 
place the graphic within it.
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Cropping a graphic
Page 108: It’s important for students to understand that a graphics frame and the 
graphic within can be selected and modified independently. To crop a graphic, 
you change the size of the graphics frame by dragging any of its handles with the 
Selection tool. Changing the crop of an image does not change the image itself (that 
is, the original graphics file is not affected by cropping within InDesign). The visible 
area is all that changes when you resize a graphics frame.

Importing multiple graphics into a grid of frames
Page 109–110: Previous versions of InDesign let you place multiple graphics by 
using the Place command or dragging and dropping graphics files. InDesign CS5 
adds to this feature by giving you the option to create a grid of identically sized and 
equally spaced graphics frames when you import multiple graphics.

Scaling and moving graphics
Page 110–112: The ability to select both a graphics frame or the graphic within a 
graphics frame with the same tool (the Selection tool)—a new feature in InDesign 
CS5—greatly reduces the need to switch tools when working with graphics and 
graphics frames. Make sure that the student understands that clicking within the 
content indicator doughnut when the hand pointer is displayed and then dragging 
moves the graphic, while clicking outside the content indicator doughnut when the 
arrow pointer is displayed and then dragging moves the frame and the graphic.

Using the Gap tool
Page 112–113: The Gap tool is also new in InDesign CS5. It lets you resize multiple 
objects with commonly aligned edges while keeping the gaps between them consis-
tent. It’s a powerful tool, but much of its versatility is the result of using modifier keys 
while dragging. If time allows, students can experiment with the different modifier 
keys: Shift, Ctrl+Shift, (Windows), Command-Shift, Alt (Windows) and Option 
(Mac OS).

Generating captions using metadata
Page 113–114: Students should understand that the more tasks they can automate, 
the more time they’ll have for being creative. The ability to automatically generate 
captions for graphics frames by extracting information stored in the original graphic 
file eliminates time-consuming manual labor. This feature can be invaluable for 
publications with a large number of graphics and captions. 
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Changing the shape of a frame
Page 116, step 7: This task is another example of the difference between the 
Selection tool and the Direct Selection tool. When students attempt to drag the 
upper-right corner of the frame, make sure that only the upper-right point is 
selected. This may require clicking off of, then on the upper-right corner point with 
the Direct Selection tool. 

Text wrap
Page 116–118: While this exercise has students wrap text around a polygon, you 
will most frequently use the second button in the Text Wrap panel (Wrap Around 
Bounding Box) to wrap around the bounding box of an object. If you apply a text 
wrap to an object, text within text frames that are either above or below the object is 
affected. If you want to wrap text only around objects that are in front of text frames, 
select Text Wrap Only Affects Text Beneath in the Composition section of the 
Preferences dialog box (Edit > Preferences > Composition on Windows; InDesign > 
Preferences > Composition on Mac OS). Text wraps are applied to text regardless of 
the layer on which objects are placed.

Using the Pathfinder panel
Page 119, step 4: This lesson covers only one of the five options in the Pathfinder 
section of the Pathfinder panel; however, the other options are easy to use and make 
it easy to create complex shapes that would be difficult to draw with the Pen tools. 
If time allows, have students create some overlapping shapes on the pasteboard and 
then try some of the other Pathfinder options. Show them how two overlapping 
circles and the Subtract button can create a crescent moon and how three overlap-
ping and the add button can be used to create a snowman.

Creating polygons and converting shapes
Page 119–121: The Polygon and Polygon frame tools let you create equilateral poly-
gons and starburst shapes that can be used as containers for text or graphics or filled 
or stroked with color and used as graphic elements. After you create an object, you 
can change its shape by selecting it with the Direct Selection tool and then dragging 
any of the object’s anchor points, or you can choose Object > Convert Shape and 
then choose any of nine basic shapes.

Adding corner effects to a frame
Page 121–122: InDesign has always let you apply special effects to the corners of 
objects, but before InDesign CS5, you’ve had to apply the same effect to all corners 
of a rectangular frame. If you want to apply different effects to the corners of a rect-
angular frame, select the frame, and then choose Object > Corner Options. In the 
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Corner Options dialog box, Uncheck Make All Settings The Same, and then choose 
an effect for each of the four corners.

Rotating objects vs. rotating content
Pages 123–124: InDesign provides several options for rotating objects. New in 
InDesign CS5 is the option to click slightly outside the corner handle of a selected 
frame or graphic and drag in a clockwise or counter-clockwise direction. You can 
also use the Rotation tool, the Rotation Angle field in the Control panel or the 
Transform panel, or you can choose Object > Transform > Rotate. Although it’s 
possible to rotate a graphic within a graphics frame by selecting the graphic and 
then using any of the aforementioned options, it’s not possible to rotate the text 
within a text frame. 

Aligning objects
Page 125–126: While ruler guides and Smart Guides are helpful for aligning objects 
as you create them, the Align panel is helpful for aligning multiple objects that 
you’ve already created. The Align panel consists largely of buttons that indicate 
how the selected objects will align with each other if you click. If time allows, have 
students create a few sample objects on the pasteboard, select them, and then click 
the various buttons to see the results.

Scaling objects
Page 126–127: The task of scaling multiple objects has been simplified in InDesign 
CS5 by removing the requirement that you group multiple objects before you scale 
them. Once you’ve selected objects you want to scale, the easiest way to scale them 
is to drag any of the corner handles of the bounding box that contains the objects. 
Hold down the Shift key when dragging to maintain the proportion of all objects.

Selecting and modifying an object within a group
Page 127–128: You can select an object that’s part of a group by clicking it with the 
Direct Selection tool. Another method is to double-click an object within a group 
using the Selection tool. Once you’ve selected an object in a group by double- 
clicking it with the Selection tool, you can select any other object in the group  
(and not select the entire group) by clicking it. 

Questions
1	 What kinds of publications benefit from having multiple layers?

2	 What is the difference between the Selection tool and the Direct Selection tool?

3	 What’s the easiest way to cause text to flow across three equal-sized, equal-
spaced columns?
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4	 What tool is best for creating a placeholder frame for a graphic?

5	 How do you cause text to flow around an object instead of through it?

6	 What aids does InDesign offer for aligning objects?

Answers
1	 Publications that have numerous objects benefit from having layers because 

you can organize different types of objects onto different layers. One simple 
implementation of layers is to create one for Text and another for Graphics. 
Place text objects on the Text layer; graphic objects on the Graphics layer. Once 
you’ve organized objects onto layers, you can use the Layers panel to show or 
hide and lock or unlock individual layers. InDesign CS5 also lets you show/hide, 
lock/unlock each object on a layer.

2	 Use the Selection Tool to manipulate an entire frame or the graphic within a 
graphics frame. For example, use the Selection tool to move a frame (text or 
graphics) and its contents or to change the dimensions of a frame. You can also 
use the Selection tool to select and move a graphic within a graphics frame by 
clicking within the content indicator doughnut and dragging. Use the Direct 
Selection tool to select and move individual anchor points and line segments  
of a frame. 

3	 Use the Type tool to create a rectangular text frame, then choose Object > 
Text Frame Options. In the Text Frame Options dialog box, set the Number 
of Columns to 3. Text will automatically flow from the top of the first column, 
through the middle column, and to the bottom of the third column.

4	 You can use either the Rectangle tool or the Rectangle Frame tool to create a 
frame for an imported graphic. The Rectangle tool creates an unassigned frame; 
the Rectangle Frame tool creates a graphics frame. You can import a graphic (by 
using either the Place command or by dragging and dropping a graphic file) into 
a frame created with either of these tools. The Rectangle Frame tool is often used 
to create placeholder frames for graphics because an empty frame created with 
this tool is displayed with an X through it to indicate there is no content.

5	 By default, when an object overlaps a text frame, InDesign ignores the 
overlapping object and flows the text as though it wasn’t there. If you want the 
text to flow around the object rather than through it, you must apply a text wrap 
to the object. The Text Wrap panel offers several controls for specifying how text 
flows when the selected object overlaps a text frame.

6	 InDesign offers several options for aligning objects. When Smart Guides are 
enabled, InDesign snaps object centers and edges to the centers and edges of 
other objects on the page as you drag. You can also create horizontal or vertical 
ruler guides and use them to align edges when you create or reposition objects, 
and you can use the Align panel to align multiple objects and optionally apply an 
equal amount of space between them.
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Lesson 5: Flowing Text
Because most InDesign documents include text created using other programs, you 
should become familiar with the process of importing text and flowing it through 
the pages of a document. Remind students that if they misplace or replace text 
when placing or threading that Edit > Undo will work wonders.

Flowing text into existing frames
Pages 135–137: When working with a template—the predesigned shell of a docu-
ment—text frames often already exist. In this case, you can type or import text into 
these frames. 

Flowing text manually
Pages 137–140: When working with text that continues across one or two pages, 
you might thread the text frames manually. Threading text frames requires the 
Selection tool. While threading frames, you can create new text frames as well.

Flowing text automatically
Pages 140–143: InDesign CS5 provides methods for automatically flowing text 
through threaded frames, even adding pages as necessary. Since so many text-flow 
methods exist, remind students to look up the method they need in the Help file.

“Continued on” lines
Pages 144–145: Creating “continued on” lines, also known as jump lines, requires 
precision. Make sure text wrap is not applied to any objects that the jump line text 
frame is near. Also, make sure that the two text frames fully touch to get the Next 
Page Number to work.

Questions
1	 How do you load the Type tool with text files to import? 

2	 What tool lets you thread text frames?

Answers
1	 To load the Type tool with text files to import, choose File > Place. You can 

select multiple files to import. 

2	 The Selection tool is the only tool that lets you thread text frames. 
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Lesson 6: Editing Text
In most publishing workflows, text is created using a word-processing program 
and then imported into InDesign. This text is hardly 100 percent final, however—
most InDesign users will need to enter revisions to text that is already flowed into 
documents. In addition, some users opt to use InDesign CS5 as their primary word 
processor. 

Missing fonts
Page 151–152: Make sure students know that fonts are separate files that may or 
may not be active on their systems. A “missing font” is not active—and possibly not 
present on the system. To resolve missing fonts, users can locate and activate the 
font or replace the font with a different font. InDesign indicates missing fonts as 
follows:

•	 Missing fonts are listed in an alert when you open a document.

•	 The Font menu in the Character panel lists missing fonts in brackets.

•	 Missing fonts are highlighted in pink in the layout (except in Preview mode). 

Find/Change
Page 154–157: The InDesign Find/Change options range from simple word searches 
to finding sophisticated patterns and changing the text or formatting. Since the 
Find/Change capabilities can be overwhelming, point out to students that they can 
click Fewer Options when performing simple text searches. If it seems like Find/
Change is not working, check the state of all the buttons (such as Case Sensitive) 
and make sure nothing extra is specified in the Find Format area. 

Checking spelling
Page 159–161: InDesign provides many features for checking spelling, including 
highlighting possible misspelled words, automatically correcting spelling as you type, 
and customizing the spelling dictionary. This is a good time to remind students that 
the final word on spelling needs to come from a human, preferably an editor, as 
InDesign cannot understand context. 

Using the Story Editor and tracking changes
Page 163–165: The Story Editor isolates text in a separate window, making it easier 
to edit text on complicated backgrounds, revise long blocks of text, and make 
text fit. While revising text in InDesign, it may be important to keep track of what 
changes were made. In that case, you can track changes in the Story Editor. 
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Questions
1	 How can you spell check all the text in a document?

2	 What is the advantage of using Find/Change to search and replace formatting?

Answers
1	 You can choose the Document option in the Check Spelling dialog box (accessed 

from the Edit menu).

2	 Find/Change ensures consistent formatting by finding all instances of the 
specified text and changing the text and/or formatting consistently. 

Lesson 7: Working with Typography
This chapter provides an introduction to many of InDesign’s more refined typo-
graphical features such as baseline grids, kerning, tracking, column adjustment fea-
tures, OpenType fonts, drop caps, hanging punctuation, and paragraph composers.

Baseline grids
Pages 171–173: Because both the baseline grid and leading control the amount of 
space between lines, you need to work with both options when using the baseline 
grid. You can set leading values to be equal to or less than the baseline grid option, 
otherwise type may skip to the next grid line, which may provide too much space 
between the lines.

Space between paragraphs
Pages 173–174: New students frequently use extra paragraph returns to add spaces 
between lines. The Space Before and Space After options are the most consistent 
methods for adding space between two paragraphs. You can also use the Leading 
options for adjusting line spacing. Additionally, you can use the baseline grid to set 
the line spacing. All of these can be used with paragraph styles, making it easy to 
make changes to multiple paragraphs in a single step.

Fonts, styles, and glyphs
Pages 175–178: When working with type styles and glyphs, it’s important that 
students understand that these features are built into fonts. Since all fonts are not 
created equal, these features are not always available. 
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Adjusting columns
Page 179–181: Two new features to InDesign CS5 let you create a headline or intro-
duction that spans multiple columns and automatically balance the text in columns. 
Using these features in templates can save layout time. 

Hanging punctuation
Page 182: The feature, called Optical Margin Alignment, is a story attribute—it 
applies to all the text in a series of threaded text frames. It can, however, be turned 
off for selected paragraphs through the Optical Margin Alignment panel menu.

Drop caps
Pages 183–185: Many users do not realize that Drop Caps are a paragraph format, 
and therefore do not require you to select the characters to format as drop caps. 
Because of this, you can also specify drop caps in paragraph styles.

Letter and word spacing
Pages 185–187: Changing the kerning and tracking of headlines and larger type is 
often necessary. Make certain that your students understand the difference between 
kerning, which controls the space between character pairs, and tracking, which 
controls the space between multiple characters.

Composers
Pages 187–188: Explain the benefits of the Adobe Paragraph Composer—that it 
considers line breaks in the entire paragraph when hyphenating and justifying text. 
The Adobe Single-line Composer considers only one line at a time and may produce 
less desirable spacing. 

Working with tabs and hanging indents
Pages 188–191: Emphasize the importance of showing Hidden Characters while 
working with tabs. 

Paragraph rules
Page 192–193: You can add rules (lines) above or below paragraphs through para-
graph formats and paragraph styles. This is much quicker than drawing lines and 
anchoring them in text—or worse, drawing lines and moving them each time text 
reflows. 
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Questions
1	 How can you easily apply a drop cap to all of the first characters used in multiple 

stories across a document?

2	 What does pink highlight on text mean?

Answers
1	 You can create a paragraph style and apply it to the first paragraphs where you 

want the drop cap to appear.

2	 If text is highlighted in pink, the font applied to that text needs to be activated on 
your system. 

Lesson 8: Working with Color
This lesson provides a more detailed look at the methods for creating, saving and 
applying colors, gradients, and tints. 

Preflight profiles
Page 199: Explain to users that their output providers (commercial printers) can 
provide Preflight profiles that help ensure that their documents use the appropriate 
colors, fonts, stroke widths, and more. 

Color swatches
Page 200–203: Creating color swatches is similar whether you are mixing CMYK 
colors or choosing spot colors (such as a PANTONE color). Encourage students to 
work primarily in the Swatches panel, as it provides one central location for creating, 
saving, applying, and modifying colors.

Dashed strokes
Pages 204–205: While InDesign provides a great many stroke choices, you can also 
create customized stroke types by choosing Stroke Styles from the Stroke panel 
menu. These styles then become available in the Type drop-down menu in the 
Stroke panel.

Gradient swatches
Pages 205–207: More advanced students might experiment with creating gradients 
with more than one color. You can click on the bottom of a gradient ramp, between 
the two stop colors to add an additional stop color. You can then change the addi-
tional color to meet your needs. 
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Tint swatches
Pages 208: For consistent usage, you can save tints (or shades of colors, such as 70 
percent black) as swatches. 

Type and object color
Page 211–212: Since color can be applied to the stroke or fill of selected text or the 
background of a text frame, students need to follow the steps in this section closely.

Questions
1	 How can you edit the name or attributes of a color swatch?

2	 How do you create a new color swatch?

3	 How can you change a spot color to a process color?

Answers
1	 You can double-click on a color swatch to edit its name and attributes. Be careful 

that you do not have an object selected when you do this, as you may apply the 
color to the object at the time you click the swatch to edit it.

2	 You can click the New Color Swatch button or choose New Color Swatch from 
the Swatches panel menu. 

3	 You can edit the swatch and change it to a Process color and change its Color 
Mode to CMYK and its Color Type to Process.

Lesson 9: Working with Styles
Styles are a critical feature for any document that uses repetitive formatting, espe-
cially longer documents. Too often styles are under utilized by students—they don’t 
want to be bothered with creating them. You should encourage your students to 
gain a firm grasp of the concepts and features for character, paragraph, object, table, 
and cell styles. Also, it is important to distinguish early on between paragraph and 
character styles.

Paragraph styles
Page 223–226: Emphasize to students that you only need to click in a paragraph 
to apply a paragraph style—you don’t have to select the whole paragraph. All the 
formats apply to all the text in the paragraph.

Character styles
Page 226–229: Character styles apply to selected text within a paragraph. Generally, 
users create character styles to quickly apply multiple formats (such as font, size, 
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and style) in one click. You can also create a character style to easily apply a single 
format—such as Bold or Italic. When creating a character style, any formatting not 
explicitly identified in the New Character Style dialog will remain as-is after the 
application of the style. So a single style that applies the Bold format can be used to 
create Minion Pro Bold and also Adobe Garamond Pro Bold (providing that both of 
these fonts are installed).

Nested styles
Pages 229–235: If you have paragraphs that always start with a certain formatting 
pattern, you can combine character and paragraph styles together to build a nested 
style. Nested styles allow you to automatically style the first several words or char-
acters of a paragraph using a character style, then format the remaining portion of 
a paragraph using a paragraph style. The formatting occurs in a single click. If your 
students are advanced, you may want to have them add multiple character styles as 
a nested style or experiment with line styles.

Object styles
Pages 235–240: Object styles allow users to save formatting applied to frames—
including formatting applied to text and graphics inside of a frame. 

Table and cell styles
Page 240–245: Table and cell styles allow users to save formatting applied to tables 
and cells—including formatting applied to text inside of a cell.

Updates to styles
Page 245–247: You can update character, paragraph, object, table, and cell styles to 
match new formatting using the same technique. Updates to styles automatically 
affect all instances where the style is used. 

Loading styles
Page 247: If you’ve already created styles in another document, you can import them 
into another InDesign file using the Load command from the panel menu.

Questions
1	 How do character styles differ from paragraph styles?

2	 When applying a character style, what steps are necessary, and how does this 
differ from applying a paragraph style? 

3	 What types of styles are involved in creating a nested style?
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Answers
1	 Character styles include only character formats (font, size, color, scaling, kerning, 

etc.)—the formats that are located in the Character panel and not those located 
in the Paragraph panel.

2	 When applying a character style you must first highlight the text to be formatted. 
Only the highlighted text is styled when applying a character style. Alternatively, 
paragraph styles apply formatting to an entire paragraph, even if the cursor is 
only inserted in the paragraph. No text needs to be highlighted when applying a 
paragraph style.

3	 A paragraph style and a character style.

Lesson 10: Importing and Modifying Graphics
By default InDesign saves the location (that is, the pathname) of graphic files that 
are imported into an InDesign layout; it does not save placed graphics within the 
document file because this could result in enormous and unwieldy files. (Note: It is 
possible for users to choose to embed graphic files within an InDesign file, though 
this is generally not recommended.) This lesson provides a foundation for manag-
ing imported graphics using the Links panel, working with clipping paths and alpha 
channels, and using an InDesign library file to store frequently used graphics and 
other elements.

Missing and modified images
Page 256–261: The Links panel displays a list of all graphic files that have been 
imported into a document. When you print an InDesign document, the original 
graphic files are sent to the printer along with the InDesign document. Remind 
students that they should watch for yellow triangles, which indicate images that may 
have changed since the time they were imported, and red stop signs, which indicate 
that InDesign cannot locate the original graphic file. Although it’s possible to print 
and export InDesign documents that contain missing or modified graphics, this 
is generally not advisable because low resolution versions of the modified/missing 
graphics are used instead of the original files.

Note that you can also maintain links to imported text files, and placed text files are 
listed in the Links panel along with placed graphics. However, this is not a common 
workflow and is not covered in this training. 

Adjusting view quality
Page 261–262: The Typical Display view setting is the default for imported graphics 
and uses a low-resolution image that’s appropriate for identifying and position-
ing graphics. If you have a need to see the original, high-quality artwork, you can 
change the view setting for a particular graphic by selecting its frame with the 
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Selection tool and then choosing Object > Display Performance > High Quality 
Display. You can change the view setting for the current document by choosing 
High Quality from the Default View menu in the Display Performance section of the 
Preferences dialog box. If you change the default view setting when no documents 
are open, the option you choose becomes the default setting for all subsequently 
created documents. Caution students that working in High Quality display mode all 
of the time can slow down performance.

Working with clipping paths
Page 262–265: The Clipping Path dialog box lets you to mask out certain areas of 
a selected graphic by choosing Alpha Channel or Photoshop Path from the Type 
menu. These paths and alpha channels are stored within the original graphic files. 
The lesson shows students how to use the Detect Edges option in the Clipping Path 
dialog box to create a clipping path for a graphic that doesn’t have one. Caution 
students against using the Detect Edges option for every image that requires a clip-
ping path as this can add significant size and complexity to a document. Photoshop 
is still the best option for most objects that require a clipping path.

Working with alpha channels
Page 265–270: This lesson requires the use of Photoshop. If you are teaching a class 
that is focused on typography, you may want designate this lesson as optional. The 
features covered in this lesson help InDesign users understand that the preparation 
of an image in Photoshop impacts the options for displaying the image in InDesign.

File formats
Page 270–277: Although students work with .psd, .ai, and .pdf files in this lesson, 
you can use virtually any file format for practice purposes. InDesign supports for-
mats such as .tif, .eps, and .jpg, to name a few. Native file formats (.psd and .ai) offer 
some advantages. For example, .psd files can include clipping paths, alpha channels, 
and layers, and InDesign provides access to all of these display-related elements, 
allowing the InDesign user to control how the graphic is displayed and output.

Creating a library
Page 277–279: As stated in the book, caution students about image linking in a 
library. If you add an imported graphic to a library and then copy the library item 
into a document, InDesign must still access the original graphic file when print-
ing and exporting the document. If you embed a placed graphic (by selecting the 
graphic in the Links panel and then choosing Embed Link from the Links panel 
menu) and then drag the graphic frame into a Library panel, the graphic will be 
embedded in any document you later drag it into from the library.
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Questions
1	 Why is it important to maintain the link to the original file after you import a 

graphic?

2	 What should you do if you want to display an imported graphic at the highest-
possible resolution in InDesign?

3	 What is the benefit of adding clipping paths and alpha channels to graphics files?

Answers
1	 Because InDesign uses the original source graphics files when printing a 

document, most graphics will not print at the highest-possible resolution (nor 
will they export to PDF using the best-possible resolution) if the link to the 
original graphics file has been broken. This can occur if the original file has been 
moved, deleted, or renamed.

2	 Select the graphics frame with the Selection tool, and then choose Object > 
Display Performance > High Quality Display.

3	 Adding clipping paths and alpha channels lets you control which portions of 
an image are displayed onscreen and print without deleting parts of the image. 
Clipping paths and alpha channels are most-often created using an image-
editing program, such as Photoshop. If you import images with clipping paths or 
alpha channels into an InDesign layout, you can print the image using any path 
or channel or you can ignore them and print the entire image.

Lesson 11: Creating Tables
Tables make it easier to present large amounts of data. Tables are created within 
text frames, and can be easily controlled through the Tables panel and the Table 
menu. You can also use the Control panel to manipulate tables. You can import 
tables from Excel and Microsoft Word, copy and paste a table into a layout, or con-
vert existing text to a table.

Imported tables
Page 294–295: While importing tables created in Microsoft Word or Excel, you 
can specify which Excel sheet to import or choose a cell range or from a Microsoft 
Word document. You can maintain a link to these imported tables, but if you 
update them in the document, any formatting applied in InDesign will be lost.

Table formats
Page 296–298: You can format an entire table, including specifying formatting for 
alternating patters of rows, and you can format individual or selected cells. 
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Table headers
Page 299–301: Tables can be linked across multiple text frames, and table head-
ers appear at the top of each frame containing the table. You can have your more 
advanced students experiment with creating tables that span multiple text frames, 
and add table headers that appear in each frame.

Table panel
Page 302–303: While the Table panel provides a comprehensive set of options for 
creating and manipulating tables, you can also use the Control panel for many, but 
not all, of the options covered in this section. You may want to have your students 
learn the concepts with the Table panel and then let them experiment with the 
Control panel.

Graphics in table cells
Page 303–306: The only way to place graphics in tables is as inline (anchored) 
graphics. They need to be copied and pasted or imported into a cell when you have 
a text insertion point (blinking cursor).

Column width
Page 311–312: When dragging columns and row with the Type tool, holding down 
the Shift key will resize just the columns or rows affected, not the overall width or 
height of the table.

Questions
1	 How are graphics imported into a table?

2	 How do you easily select an entire row, a column or the entire table?

3	 How do you add or delete rows and columns?

Answers
1	 You can choose the Place command when the cursor is inserted in a table cell, 

or you can choose the Paste command after copying a graphic.

2	 You can move your mouse to the outside portion of a row or column and click 
when the black arrow appears. You can also move your cursor to the upper left 
corner of a table and click when the arrow appears to select the entire table.

3	 You can add or delete rows by entering a larger or smaller number in the rows 
or columns section of the Table panel. You can also choose the Insert or Delete 
commands from the Table panel menu.
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Lesson 12: Working with Transparency
InDesign supports several see-through effects—referred to collectively as transpar-
ency. You can import Photoshop and Illustrator graphics that include transparency, 
and you can add transparency effects to InDesign objects. This lesson shows some of 
the ways in which you can modify InDesign objects using the transparency features 
available in InDesign.

Layers
Students are instructed to turn layers on and off throughout this lesson. Make sure 
to have students follow the instructions closely. If they discover that they cannot 
access something in the lesson because a layer is locked or hidden, instruct them go 
to the Layers panel and correct the problem.

Colorizing grayscale images
Page 307–309: Note that you can apply color to black-and-white and grayscale bit-
map images, and you can also colorize the background color (that is, the fill color) of 
graphics (and other) frames.

Opacity vs. tint
Page 311-312: Specifying an opacity value and specifying a tint value are similar 
but different in one important way. When you apply a tint to an object’s fill or 
stroke, the fill or stroke gets lighter as the tint value gets lower, and the fill or stroke 
remains opaque. (A tint value of 0 makes the fill or stroke opaque white.) As you 
lower an object’s opacity, the object gets both lighter in value and translucent (that 
is, objects beneath it become visible where they were previously obscured by the 
opaque object at 100% opacity).

Applying transparency effects to imported  
Photoshop and Illustrator graphics
Page 315-317: Applying transparency effects to imported Photoshop and Illustrator 
graphics is the same as applying them to objects created within InDesign. That 
is, you can apply transparency effects to any object: a straight line, a text frame, 
a graphics frame, an empty polygon shape, and so on. Mention to students that 
although it’s possible to apply transparency effects separately to the stroke of a 
frame, the fill, and the text within, in most cases, the default choice (Object) in the 
Settings For menu in the Effects dialog box works best when applying transparency 
effects.
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Applying transparency effects to text
Page 318-319: Mention to students that although it’s possible to add a drop shadow 
to the text within a text frame without adding a shadow to the frame’s stroke or fill, 
it’s not possible to add a drop shadow to individual text characters or to a high-
lighted range of text.

Applying other effects
Page 319–325: You can apply a gradient feather to an object using any of several 
methods. One of the easiest ways is to select an object, then select the Gradient 
Feather tool and drag across the object. You can then edit the effect in the Effects 
panel. Time permitting, have students experiment with some of the other transpar-
ency effects using other text and graphic objects on the page.

Page 325, step 12: Students may miss the mark when dragging the FX icon onto the 
green semicircle. If they miss, it’s easy to undo and try again.

Editing and removing effects
Page 325–326: The sheer number of controls in the Effects dialog box combined 
with the option to apply one or more effects separately to an object, its stroke, its 
fill, or the text within a text frame. Make sure that students realize that by using the 
Clear Effects button, all effects are removed, including blending modes, opacity, and 
all transparency effects.

Questions
1	 You can make an object’s stroke or fill lighter by either lowering the tint or the 

opacity of the stroke or fill. What’s the difference between lowering an object’s 
tint and lowering its opacity?

2	 What is the advantage of creating transparency effects within InDesign?

3	 Why is it important for a page-layout program to support transparency?

Answers
1	 If you were to specify a 50% tint for the fill of an object and a 50% opacity for a 

copy of the object, you wouldn’t be able to tell the difference between the two 
unless they overlapped other objects. An object with a 50% tinted fill is opaque; 
an object whose fill has a 50% opacity is translucent.

2	 You can create transparency effects, such as soft drop shadows for text, using 
InDesign, Illustrator, or Photoshop; however, if you’re working on an InDesign 
layout, using the program’s built-in transparency features eliminates the less-
efficient alternative: creating the elements using a separate program and then 
importing the graphic files into InDesign. If you need to modify something in 
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an imported graphic, you must open the original file in the application used to 
create it, make changes, and then resave the file—considerably more work than 
modifying the element within InDesign.

3	 Because transparent elements can be created using Photoshop and Illustrator, it 
is important that page layout programs have the ability to handle these items. 
Images with feathered edges or pictures with transparent elements (such as 
a glass) can be successfully used only in a page layout program that supports 
transparency in placed graphics.

Lesson 13: Output and Exporting
The primary destination for many InDesign files is a printed publication. This 
chapter covers the tools for successfully printing with InDesign. Whether your 
publication is a brochure, package design, or newsletter, you need to know how to 
check the file for potential printing problems before they actually occur and how 
to achieve the desired results when printing. A large and ever-growing number of 
print service providers accept InDesign files, and you can also create PDF files for a 
variety of purposes— including high-resolution printing and online distribution.

Using the Preflight panel
Page 333–334: Preflighting a document for potential printing problems is essential 
before handing-off an InDesign file for final output. The Preflight panel lets you per-
form live preflight throughout the production process rather than waiting until final 
output is required. Preflighting as you work lets you identify and correct potential 
printing issues as soon as they occur. Whether you intend to provide the file to a 
commercial printer or a colleague, preflighting determines whether all files neces-
sary to print the document are available and alerts you if you do something that 
violates the current preflight settings.

Using the Package command
Page 334–337: In addition to collecting all of the files required to print an InDesign 
document, packaging a file is a great way to create an archived version of a docu-
ment. Make sure that students understand that every time they package a file, they 
create copies of all of the imported graphic files, fonts, as well as the InDesign file. 
Once they’ve sent a package folder to the printer, they may want to delete the folder 
to avoid redundancy and save disk space, or they can make a copy of the folder on a 
different hard disk or CD before deleting the package folder from their hard disk.

PDF quality options
Page 337–338: Note that there are a variety of settings that control the quality of the 
final PDF document. It is important to select a setting that matches your needs for 
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the final PDF. Using the High Quality Print PDF preset might be the best option for 
creating a PDF for proofing purposes, but this could produce an impractically large 
file to post on-line. If students have questions about the PDF/X options and you 
are unsure about how to answer them, you can find a wealth of information on the 
Adobe website. Go to www.adobe.com and search for PDF/X.

Separations Preview panel
Page 339–340: You can preview individual color separations, ink coverage limits, 
and overprinting using the Separations Preview panel, however, you cannot preview 
trapping, halftone screens, and resolution. You should work with your printer to 
verify these settings using integral or overlay proofs.

Printing a laser or inkjet proof 
Page 343–348: When working through this section, it is important to inform stu-
dents who are not connected to a printer that they should choose either PostScript 
file from the Printer menu and Device Independent from the PPD menu in the Print 
dialog box or choose an installed print driver. If they choose PostScript and Device 
Independent, some of the controls in the Print dialog box that are covered in this 
lesson are not available. Because of the number of printer manufacturers and mod-
els and the different ways a computer can connect with a printer, it’s not possible to 
provide detailed printing instructions that apply to every possible situation. It is easy 
to adapt the tasks in this lesson to work with whatever printers and connections are 
available.

Using the Ink Manager
Page 349–350: If you’re working on a color publication, the Ink Manager provides 
an easy way to control the number of plates that are produced when the document 
is printed as color separations. It’s especially useful for mapping spot colors to 
CMYK colors in a publication that will be printed using only CMYK colors.

Questions
1	 If you print to multiple printers, what’s the fastest and easiest way to ensure that 

you use the correct settings for all printers?

2	 How can you confirm what ink separations will print?

3	 What are some of the advantages of InDesign’s integrated PDF export?

4	 Why are there several different types of PDF files?
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Answers
1	 Create a Print Preset for each printer. For example, if you use a black-and-white 

printer to output some proofs and a color printer for others, you can create a 
print preset for each printer and choose the one you want at print time from the 
Print Preset menu in the Print dialog box.

2	 You can use the Separation Preview panel or the Ink Manager. The Separations 
Preview panel displays a list of CMYK and spot colors and lets you show or hide 
individual colors. The Ink Manager displays a list of colors used in a document 
and lets you convert spot colors to process colors and map one color to another.

3	 Because you do not need to generate PostScript files and then use Acrobat 
Distiller, the task of creating PDF files is simpler and faster than it used to be. 
The integrated PDF export also provides for enhanced PDF options, such as the 
inclusion of multimedia elements (sounds and movies) and buttons that would 
otherwise not be possible. Many print providers like to receive PDF files instead 
of InDesign documents because all files required to print a PDF—including fonts 
and imported graphics—are contained within the file.

4	 The options for exporting PDF files changed in InDesign CS5. You now have 
the option to choose Adobe PDF (Print) or Adobe PDF (Interactive) in the 
Export dialog box. If you choose Adobe PDF (Print), you can choose from a 
number of Adobe PDF Preset options in the Export Adobe PDF dialog box that 
determine the quality (and file size) of the resulting PDF file. Press Quality will 
create the largest file with the highest possible resolution; Smallest File Size is 
for documents that will be displayed online. You may need to export two PDF 
files if you intend to distribute a PDF file online and also use a PDF file for high 
resolution printing. The Adobe PDF (Interactive) option in the Export dialog box 
is for documents that will be viewed online and include such elements as page 
transitions, buttons, movies, and sounds, 

Lesson 14: Creating Rich Interactive Documents
The ability to create and export rich interactive documents as SWF files was intro-
duced in InDesign CS4 and has been greatly enhanced in InDesign CS5, allowing 
you to create visually compelling online publications with buttons, animations, page 
transitions, movies, and sounds. You can also export documents as Adobe PDF 
(Interactive) files that include movies, sounds, and page transitions. The ability to 
create media-rich SWF and PDF files within InDesign means that users can take 
advantage of their text-formatting and page layout skills and quickly build sophisti-
cated electronic publications without having to use a separate application or learn-
ing a scripting language.
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Creating online documents
Page 355–360. Make sure that students understand the difference between creat-
ing a media-rich document that is intended only for online use and creating a print 
document and exporting it as a PDF or SWF file as a quick online alternative to the 
print version. Documents intended for online viewing only should take advantage 
of the medium by including multimedia objects (movies and sounds) and interactiv-
ity (buttons and hyperlinks). Documents designed for print won’t include movies, 
sounds, and interactive elements. 

An InDesign document that’s intended to be viewed only online—whether it will be 
exported as PDF or SWF—will be different from a print document in several fun-
damental ways. For example, the size of an online document should be appropriate 
for a monitor. However, because monitors come in many different sizes, there are 
no dimensions that will produce optimal results on all monitors. Many designers of 
online documents design to the smallest standard monitor size (currently, the small-
est standard monitor has a 15" diagonal and is 1024 x 768 pixels, which corresponds 
to a document size of 1024 x 768 points).

Exporting as Flash
Page 360–362. Make sure that students understand that video and audio files placed 
into a document are not included in an SWF file exported from InDesign CS5. If 
you wish to include this kind of content in what will ultimately be a Flash (SWF) 
file, Adobe recommends using the export to Flash CS5 Professional (FLA) workflow 
described in the following paragraph.

Inform students that in addition to exporting InDesign documents as SWF files, 
they can also choose the Flash CS5 Professional (FLA) file format when exporting. 
This file format enables you to lay out content—including animations, videos, and 
sounds—with InDesign and then import an FLA file into Adobe Flash CS5, where 
you can add other elements and more complex interactivity.

By default, when you export an SWF file, InDesign creates an HTML file that 
includes a reference to the SWF file. The SWF content of this HTML file can 
be viewed using any browser that has the Adobe Flash Player browser plug-in. 
However, the viewing experience is better when the exported SWF file is opened 
and viewed with Adobe Flash CS5. If Adobe Flash CS5 is not available on students’ 
computers, you should download and install the free Adobe Flash Player browser 
plug-in so you can open and view the exported SWF file with a browser.

Exporting PDF files
Page 362–363. Make sure students understand that they have two choices when 
exporting an InDesign document as a PDF: Adobe PDF (Print) and Adobe PDF 
(Interactive). Interactive PDF documents should be designed from the beginning to 
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take advantage of the medium. It makes sense to include elements such as book-
marks, hyperlinks, page transitions, and movies in interactive PDFs. On the other 
hand, if you are creating a print-only publication that will ultimately be exported 
as PDF file for final output, you should avoid including interactive/multimedia ele-
ments (such as bookmarks, hyperlinks, page transitions, and movies) in the docu-
ment Exporting PDF files

Adding interactivity, animation, and video
Page 365–375. New features in InDesign CS5 let you animate objects and create 
sophisticated interactivity. Explain to students that although it’s possible to add 
online-specific elements such as buttons, animations, and multistate objects to print 
publications, these elements are intended only for online documents. For InDesign 
users, one of the major benefits of using InDesign to create animated Flash files 
is that they can leverage their page layout and typographic skills to create visually 
compelling Flash files without having to learn or use another program.

Questions
1	 InDesign lets you create documents for both print and the Web. What should 

you do when you create a new document that will ultimately be viewed only 
online and is not intended for print? 

2	 What interactive elements can you add to an interactive PDF that can’t be 
included in a print PDF?

3	 What interactive elements can you add to an SWF file that can’t be included in 
an interactive PDF?

4	 When you export an SWF file from InDesign CS5, a point (1/72 of an inch) in 
the InDesign file is equal to what in the SWF file?

5	 What programs can you use to open an SWF file?

Answers
1	 When creating a new online document, make sure to choose Web from the 

Intent menu in the New Document dialog box. This changes several default 
document settings to make them appropriate for display on a monitor. If you 
plan to use the same document settings for multiple online documents, you can 
save the settings in the New Document dialog box as a Document Preset. 

2. 	 Interactive PDFs can include MP3, SWF, QuickTime, and Flash Video files, as 
well as page transitions.

3	 SWF files can include animated objects, multistate objects, and page transitions, 
as well as the kinds of interactive elements that can be included in an interactive 
PDF with the exception of QuickTime movies.
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4. 	 A pixel.

5.	 You can view the HTML file that’s generated when you export a SWF file 
from InDesign using any browser that has the Adobe Flash Player browser 
plug-in installed. You can also open SWF files directly with Adobe Flash CS5 
Professional.

Appendix: Color Management
The process of ensuring that colors remain as consistent as possible across devices 
such as digital cameras, scanners, proofing printers, monitors, and printing presses 
is called “color management.” The Creative Suite provides plug-and-play default set-
tings that help create consistent color across applications and devices. In addition, a 
color expert can fine-tune color management processes for a specific workflow.

When working with color management, ensure that students understand:

•	 The need for color management—that different devices reproduce color in 
different ways.

•	 That the color on their monitor will never precisely match printed colors.

•	 The importance of calibrating monitors. 

Bonus Lesson 15: Working with Long  
Documents
Long document features let you manage publications that consist of multiple 
documents, including updating page numbers and generating a table of contents 
and index for the entire publication. In addition, InDesign can help you insert and 
format cross-references, footnotes, and cross-references. (Note that this lesson is 
included as a PDF on the disc.) 

Book panels
Pages 4–6: Explain that Book panels are somewhat like libraries—users create them 
as needed and add the content. In the case of Books, they add the InDesign docu-
ments that make up the publication. 

Page numbering
Pages 6–8: Whether a book uses automatic, consecutive page numbering from start 
to finish or sophisticated sets of page numbers, the Book panel can ensure up-to-
date page numbers as documents in the book are updated. 
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Text variables
Pages 8–11: In this lesson, a text variable is used to create a running footer on the 
pages. Variables, however, can be used for many purposes, including adding chapter 
numbers, running headers, and dates. 

Footnotes
Pages 11–13: Tell students that they can import footnotes from Word files and that 
they have control over every aspect of formatting the footnote marker, the footnote 
placement, and the text.

Cross references
Pages 14–16: When referencing other pages in a publication, using automatic cross 
references ensure that the page numbers stay up to date as documents are edited 
and text reflows.

Synchronize formats
Page 16–19: Synchronize makes it easy to make global changes across all the docu-
ments in a book—for example, you can change a color swatch definition or a line 
width on a master page. You can select which documents to synchronize and what 
aspects to synchronize. Make students aware that once the synchronize takes place, 
it’s difficult to undo.

Table of contents
Pages 19–22: A table of contents is generated from text formatted with specific 
paragraph styles. As a result, the accuracy of the table of contents depends on the 
proper application of styles. In addition, if documents are edited or text reflows after 
the table of contents is created, you will need to create it again.

Indexes
Page 23–29: This lesson introduces only the basics of creating index entries and gen-
erating a formatted index. In general, skilled indexers should tag text for an index.

Questions
1	 Are index entries automatically updated?

2	 How do you specify that a table of contents (TOC) and index will include all 
chapters in a book?

3	 Why create a book?
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Answers
1	 Index entries are not automatically updated. You must add individual entries or 

use the add all option to have them added.

2	 You must check the box in the Index panel for it to include book chapters. For 
you to include all book chapters in a TOC, use the checkbox in the TOC dialog 
box.

3	 Books make it easy to work with longer documents and to make certain that 
styles and colors are defines consistently across multiple files.


